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Start Geopak and Project Manager

Geopak is activated through the MicroStation menu as shown below:
Applications > Bentley Civil > Activate BENTLEY CIVIL

) W:\Highway\Design\AutomationSectionkTest\DLON2201 801003 Design\22018092.dsn, Project O

File Edit Element  Settings Tools  Uklities  “orkspace | Applications | Window  RasterPathCorrection  Bidlkems

BEMTLEY CIVIL k|| Activate BEMTLEY CIVIL
1 r = £
MR AR MR A DR H R R

) view 1 - Project Overview

After Geopak is activated, the Project Manager dialog may be accessed through the Geopak Road
Tools palette, or directly from the pull-down menu, as shown below. The Road Tools palette is
shown below, right.

Applications > Road > ROAD Tools or Applications > Road > Project Manager

gpplicakions | \Window  RasterPathCorrection  Bidlkems  Hel

CIVIL 3 — i
DRAINAGE — jerct Manager: Project Manager
{3 L3
+ 4+
I LANDSCAPE Q.., =
[ RosaD v ROAD Todls "
SITE , . F i, o
Project Manager
I SHIRuUCY L S
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Chapter 21 — Automation Tools Instructions Section 21B-65 — Geopak Project Manager

Geopak Project Manager Setup

The Geopak Project Manager is used to organize information associated with each specific design
project. The following information is stored as part of a project:

e The values in the Geopak User Preferences dialog will reset to the values stored with the
selected project. This eliminates the need to reset the Geopak User Preferences manually
each time you switch to a new project.

e Project Manager is also used to store Design file information associated with a project.
Working Alignments will be discussed later.

e Coordinate Geometry information is associated with centerlines, existing profiles,
proposed profiles, cross sections, etc. for each specific alignment within a given project.
This information can also be stored in Project Manager.

e The name of the existing and proposed Digital Terrain Model, (DTM,) files can be stored
with Project Manager. DTM’s will be discussed elsewhere.

There are 2 steps to creating a project in Geopak::

1. Create the project
2. Create users for the project

To create a new project

Access Project Manager as previously shown, and also shown below:

Applications > Road > Project Manager

o0 Project Manager Q|§|g|

Projects Admin

nSections T est\DLO 42207801 0034Designs
Filter: | . prj Tope: | Project »

Praojects: Directories: ~
[

[Cogalnput]

[Concept]

[Criteria]

(D25 ubmittal]

[Dr35 ubrnittal] hl

Job Murmber: 018 Unit System: Englizh

Dezcription:

Select the Current Working Directory, as shown below.

[ Project Manager E“E§|

Projects | Directary | Admin

Create Mew Directary... \Design’

Current Warking Direckory |
T =T

.=
Filter: | * 57 b
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Chapter 21 — Automation Tools Instructions Section 21B-65 — Geopak Project Manager

To access the Create New Project dialog, select Projects > New from the Project Manager
pull-down menu, shown below.

i Project Manager EHE E]

Projects | Directory  Admin

| Mew,.,

Edit... ‘\

£ Create New Project [ x|

Project Marme: | GEOPAK. Training
Wworking Directony |w:'xF'roiects'xYourF'roiectNuml:uer Select... |

Job Mumber; |'|23 Select |
Preferences |

Project Dezcription:

GEOPAK. Road Project Manager Training

0k | Cancel |

In the Create New Project dialog, complete the following information:

Project Name — The name of the new project being creating. In the example above, the
file “"GEOPAK Training.prj” will be created in the directory that was specified in the Project
Manager dialog.

Working Directory —
Leave the Working Directory field blank - If this field is left blank, Geopak will use
the same directory as the location of the currently opened MicroStation design file to
open or save all Geopak related files. Use this option if all Geopak related files are to
be stored in the same directory as the MicroStation design files.

Specify a Working Directory - If a multiple directory structure is being used for the
project, and the Geopak related files are to be stored in a different directory than the
one that contains the MicroStation design file, the alternate directory can be specified
by use of the Working Directory field.

Job Number — This is the 1 to 3 digit alpha/numeric designation to be used by Geopak to
create a Coordinate Geometry (COGO) database for the project. In the example above,
using the three characters 123, a Coordinate Geometry database named job123.gpk will
be created in the directory that is specified as the Working Directory. The Select button
is used to select a previously created GPK file for use by this project.

Project Description — The Project Description is optional.

Preferences — Select this button to access the User Preferences dialog shown below.
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Chapter 21 — Automation Tools Instructions Section 21B-65 — Geopak Project Manager

User Preferences

Fl User Preferences

= Output Accuracy
Distance: | 9912 b
Coordinates: | ME w
o i Statior: | 3+33(3).12 v
Direction: | Bearng W =
Angle Seconds; | 979912 b
Station; | 12+34 w
Working Directany: Q,
[ Eeature Preferences. . ]
[] Shaw this dialog at startup
[ COGO Preferences. .. ]
[ [n] 4 ] Cancel

It is easy to set or change the number of decimal places for output files, station formatting,
coordinate format, English or Metric units, etc. These parameters are not only utilized by coordinate
geometry, but also by many of the other Geopak functions.

Once these preferences have been set, they are stored in a MicroStation resource file. Every time
Geopak is started, the settings of this dialog box are retained from the last design session. If you are
working on multiple projects with different units and different Working directories, The User
Preferences will need to be manually adjusted each time you open Geopak. Each option on the
User Preferences dialog is explained in the following sections:

Unit System (Metric, English)
Options are Metric and English. The Unit parameter affects every Geopak component.

Coordinates (NE, XY)
Sets either NE (Northing/Easting) or XY coordinate values in Coordinate Geometry and
Labeling components.

Direction (Bearing, Azimuth)
Sets the direction format for such variables as line direction in Coordinate Geometry, Labeling
and Components within the D&C Manager.

Station (1+234, 12+34, 1234)
Sets the format for station variables in Coordinate Geometry, Labeling, and components within
the D&C Manager.

Output Accuracy

Distance (0 to 6 decimal places)
Sets the number of decimal places for most non-station and non-angle variables in the
GEOPAK Coordinate Geometry, Labeling, and components within the Design and
Computation Manager. Variables affected by the Distance Decimal parameter include
point coordinates, curve parameters such as length and radius, inverse distance,
elevations, etc.

Station (0 to 6 decimal places)
Sets the number of decimal places for station variables in Coordinate Geometry, Labeling
and components within the Design and Computation Manger.
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Angle Seconds (0 to 6 decimal places)
Sets the number of decimal places for angle variables in Coordinate Geometry, Labeling
and components within the Design and Computation Manger. Variables affected by the
Angle Sec. Decimal parameter include curve delta and degree, bearings and inverse
angles.

Working Directory
Simply stated, the Working Directory is where Geopak will “look” for and store files. The
working directory can be assigned in one of two ways:

Leave the Working Directory field blank - If this field is left blank, Geopak will use the same
directory as the location of the currently opened MicroStation design file to open or save all
Geopak related files. Use this option if all Geopak related files are to be stored in the same
directory as the MicroStation design files.

Specify a Working Directory - If a multiple directory structure is being used for the project, and
the Geopak related files are to be stored in a different directory than the one that contains the
MicroStation design file, the alternate directory can be specified by use of the Working
Directory field.

The hour-glass “browse” button can be clicked to select the Working Directory .

Feature Preferences
The Feature Preferences option is used to assign the database that will be used for mapping
survey data and visualizing COGO data. Selection of the Feature Preferences button activates
the dialog shown below.

1! Feature Preferences E“E|g|
CADD G eopak \SMDFilez\Cogovizualization. sm Q, ﬁ-
[] &pply Best Match Feature Plat Scale: 1000000
[] Use Shared Cells Point Label Redraw: | Position by SMD Settings

Feature Database (SMD File text field)
The symbology for the elements drawn from the survey data is determined by the feature
code of that element. These feature codes are stored in a database, the Survey Manager
Database (smd file) that can be assigned as desired.

When the survey data is being mapped, as each element is created, the feature of that
element is searched for in the .smd file. If a match is found, then the symbology for that
feature is used. If a match is not found and there is a feature named “default” in the .smd
file, then the “default” feature symbology is used. If the feature is not found in the .smd file
and no “default” feature is defined in the .smd file, the current Microstation symboogy is
used.

The hour-glass “ Select SMD file” icon may be used to select the .smd file from a list. The
lowa DOT standard .smd file is located in the following directory

W:\Highway\Design\Caddinformation\Geopak\SMDFiles\IAFEAQ7.smd
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Edit SMD (book icon)
When the Apply Best Match Feature check-box (M) is checked, the best match from the
feature survey preference database is utilized. This option allows placement of one feature
in the database per item and locate derivatives, (variances), of that feature in the field.
(Example: Assume that feature EP is for “Edge of Pavement”, but in the field there are
three different EP’s that need to be located. The different EP chains can be located as
EP1, EP2, and EP3. During the mapping process, these features are matched to the Edge
of Pavement feature EP in the database. Therefore, multiple EP features do not have to
be defined in the database.)

Plot Scale (text field)
Denotes the scale utilized for drawing graphics. The sizing of the element to be placed in
the design file can be further controlled through the Survey Manager Database.

Use Shared Cells (check-box)
If checked (I4), the feature symbols will be placed as Shared Cells

Point Label Redraw (option field)
Allows for two options: Position by SMD Settings, and Position Relative to Symbol

OK (button) - Accepts the dialog settings and closes the Feature Preferences dialog.

Cancel (button)
Closes the Feature Preferences dialog without accepting any changes to the settings.

COGO Preferences
The COGO Preferences dialog is as shown below.

1} OGO Preferences g|§|@
W

dob [GPK] Open Modes | Quemy
Job [GPK] Directory: | W hProjectsh 220180710 &
COGO Input File Directary: | w\Projectsh 220180110 | O
COGO Output File Directary: | WHsProjectsh2200 80110 | C
[] Redefinition of Elements
[] Farce Redefinition Off Upon COGO Activation

[ of ] [ Cancel

The Job (GPK) Open Mode has three options: Create, No Create, Query

Three Directory fields: Job (GPK), COGO Input File, and COGO Output File
Geopak will automatically open the COGO database in the Working Directory. If none is
found, an Alert message, shown below, will appear and the software will respond in one of
three ways, dependant on the setting in the Job (GPK) Open Mode field.

Job number 123 does not exist.
0 Do you wish to create coordinate geametry

databage for Job Mumber 1237
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Create
The software will create a new database automatically if the Job Open Mode is set to
Create.

No Create
The software will not create a new database and the COGO dialog box will not be
opened.

Query
The software will prompt the user whether to create a new COGO database as shown

above. We recommend leaving this option set to Query.

Redefinition of elements (check-box)
The Redefine function will allow overwriting of COGO elements. Checking this check-box
() will force the Redefine functions on when COGO is activated. Note: Redefine can be
turned on/off directly from the COGO dialog after COGO has been activated.

Force Redefine off Upon COGO Activation (check-box)
If the Redefine function left ON the last time COGO was exited, checking this check-box
() will force the Redefine function to be OFF. It is recommended to check ([4) this option.

Show this dialog at startup (Check-box)
Checking (M) this check-box will force the User Preferences to display at start-up.

OK and Cancel buttons perform normally.

After User Preferences have been selected, click the OK button, then select OK from the Create
New Project dialog to create the project. A file, with the name supplied, will be created in the
specified directory. This file stores the name of the project, the job number and the optional project
description.

After the project has been created, the name appears in the Project Manager dialog. Select the
project and click OK to open the project.

Creating Project Users

A Project User must be selected to continue. If none exist, one must be created by selecting
Users > New, as shown below.

Project Users: MLO18. prj

Users

Mew...
Edit... Uszer Infa
Delete. .. Full Mame:
Password 0P Code.
Exit

Description:
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Geopak allows multiple users to simultaneously access the Coordinate Geometry database (.gpk file).
In order to keep track of COGO input and Output files, each person accessing the .gpk file is
assigned a user name and operator code.

MNew User

Name:

Full Mame: | John Doe |

OF Code:

Dezcription:

Key in the Name, Full Name and OP Code (Operator Code initials) for the new user. The
Description is optional.

Select OK to create the new user.

You will be prompted to define a password to protect the user name. Select Yes or No.

Do vou wish to define a password For this user?

2

e

The new user is created, and the name is added to the Project User dialog box as shown below.

Project Users: MLO18. prj

Users

['I::Jo]|ect Uzers: User Info
[Dos] Full M anne:

OF Code:
Dresgcription;

Select a user name, and pick OK to open the Geopak Road Project dialog, shown below.
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Section 21B-65 — Geopak Project Manager

Geopak Road Project dialog

Each item on the Road Project dialog represents a specific Geopak function. Many of the topics

will be explained in separate instruction files.

i Road Project: MLO18. prj

File
whorking Directony: W hProjectsh 22001 207 003Dezign

Remember  Cpkions

Alignment

Flan Wiew

Earthwiork.

Plan YWigw

Drezign
‘ (uantities

Tabular
Summaries

Flan & Profile
Sheets

i 1 0

Limits of
Construction

Crozz Section
Sheets

Reports & X5
[uantities

Lzer A Job #: 018 ]
Wrking Alignment Influence Runs
Select LCiefi Pt i
warking Aligrment | MLO18 [seteet ] [Define ] [ Portviewer ]
Exizting
Graund Ewizting Ground Ewizting Ground l Yertical
Diraw Pattem ; . i
Crosz Sections Frofile I Alighment
Coordinate
G eametry
Calculate Superelevation Propazed 3D
Supereleyation Shapes Crogz Sections il odels
Horizontal

File

The File menu has two options: Close and Exit.

Remember
The toggle options on the Rememb
Geopak to automatically open to eit

er menu include Project and User, (or none), and instructs
her the last Project or the last User, when the Project

Manager is opened. Experimentation will provide you with the best option for your personal

situation.

Options

The Options menu provides one toggle option — the Auto Sink function, on or off. With Auto
Sink turned on, selecting any of the Road Project dialog options will automatically sink the
Road Project dialog behind the MicroStation window. After the selected dialog box function is

closed, the Road Project dialog wil
provide you with the best option for

Minimize

| automatically “pop” back to the top. Experimentation will
your situation.

The Minimize toggle, (shown by the arrow below), alters the size of the Road Project dialog.
The minimized size is shown below.

) Road Project: MLO18. prj

File  Remember  Options

whorking Directany: %W A\Projectsh 220018071 0035\Dezign

‘whorking Alignment Influence Runs
WwWorking Alignment | MLO1E

SSE

Uzer Al Job #: M8 U

[ Select ] [ Define ] [ Port Wiewer ]
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Geopak Project Directory Structure
After a new Project and User have been created, a new “projdbs” sub-folder is created in the

Working Directory. This directory is used to store Project Manager information for each user.
If multiple users are created for a project, a sub directory for each user is created under the

projdbs directory, as shown below.
= |2) projdbs
= m
I 1Doe

The Working Alignment
There are two steps to setting up a working alignment, including:
1. Create an Alignment “Run”
2. Define the conditions for the “Run”

Select (button)
The Select button, shown below, is used to choose an existing working alignment or

create a new one.

4 Road Project: MLO18. prj

File Remember Options
Warking Directary: %W \Projectsh 2201 801 00340 esign User Al Job # 018 8|

Wwhorking Alignment Influence Funs
“Working Alignment | MLOTS

[5ekcty] | Define | [ Port Viewer |

Click the Select button to access the Select Working Alignment dialog, shown below.

Select Working Alignment

Bun

Mame

Untitled

D ezcription
ntitled

Cancel |

By default there is always a Working Alignment named “Untitled”.

To create a new Working Alignment, select Run > New from the .
Select Working Alignment dialog menu, as shown at the right. SglectWorkie
The New Run Name dialog will display, as shown below.
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Dezcription
aF. I Cancel I

Each Working Alignment is stored as a “Run” by Geopak. Enter a Run Name for the
new Working Alignment. The Description is optional. Select the OK button to create a
new Working Alignment.

After a new Working Alignment has been created, the name is added to previous
alignment names and displayed in the Select Working Alignment Dialog, as shown
below.

Select Working Alignment

Bun

M ame Time

Training
ntitled

Dezcription

Cahcel |

Select the design Working Alignment and click the OK button. The Road Project dialog
box is updated to reflect the currently selected Working Alignment as shown below,
(yellow arrow).

g Fload Project: geopak tiaining pr
Eile Femember Ophons

= :ﬁmﬂw IL\ E User. JDoe Job & 123 £
Woeking Aligrwvent Training ot | Thtow | o viem: |

Define (button)
The Define button, (shown above, red arrow), is used to define information about the
working alignment. Select the Define button to access the Working Alignment
Definition dialog box as shown below.
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i Working Alignment Definition: MLO18

Plar Yiew Design File: | w:\Projectsh 220180100 | O,
Pattern Chain: | MLO1E Q,
Shapes . .

Prafile Yiew Begin Station: | 0+34.21 R 1
Location End Statior;, | 0+00.00 F 2

Crozz Section Wiew
Ewxigting Ground
Propozed Finish Grade

DT

Each item on the left side of the Working Alignment Definition dialog represents a
different piece of information that can be defined for the alignment. As you work through a
Geopak project, and as new information is developed, you will continue to update the
Working Alignment Definition information.

The purpose of the Working Alignment Definition is to save specific project alignment
information in one place. These settings are shared with other Geopak dialog boxes.
Example: The first item in the list is Plan View, which is used to store the name of the
Design File that contains the proposed graphics for the project, and the name of the
Chain in the Coordinate Geometry database that is used for the centerline of the road.

When accessing the various functions of the Road Project dialog box, the settings and
parameters of the current Working Alignment run are available to all other features:
IF the parameters have been specified in the Working Alignment, and
IF the Working Alignment Influence Runs toggle is active, as shown below.
This eliminates the need to repetitively key in the same data in every dialog box.

E’Huad Project: geopak training._prj
File  Remember Options

Wa D User JDoe  Job#: 123 _I
¥ Working Alignment Influsnce Runs

Select I Paort Yiewer |

“working Alignment  Training

Note: For complete instructions, refer to Geopak Help: (from within MicroStation,
after Geopak has been activated)

Applications >
Road >
Help >
Project Manager >
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Accessing the Individual Geopak Functions
Geopak pull-down menus

Each individual function of Geopak

can be accessed from the pull down Bpplcations | Y RasterPathCorrection  Bidltems  Hed
menus, through Applications > Road, CIVIL b ) F
as shown at the right, (red arrow). | DRAINAGE o7& 0 x |01
| LANDSCAPE E i
[ rROAD b ROAD Tools
SITE —
SURVEY v ’
WATER SEwer  »  =2te Modeing
Actve Chain Control
Element Attributes

IPC AdHoc attribute Manager

Liser Preferences

Geometry k
Diersign & Computation Manager
Guantity Manager

Plame Prepuaration 2
DTM Toals

20 Tooks k
Cross Sections k
Uk ilties »
Help

dAbcag CIVIL

Geopak Road Tools palette

Alternately, the Road tool palette, (shown at
right), can be used to access all the individual ’ > =
Geopak functions. Access the Road tool B T P <
palette from the pull-down menu, as shown %;)g—' a 'r’/' RS él
above, (yellow arrow).

A complete summary of all tools is available through Geopak Help, as shown on a previous
page.
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